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1 Background 

The CTCN funded technical assistance relates to improving resiliency of crops to drought 

through strengthened early warning within Ghana. The objective is to facilitate transfer and 

capacity building for climate change adaptation focusing on dry season management and 

planning. The proposed support will utilise existing knowledge and capacity and further develop 

and validate these for applications to local issues within Ghana. 

The technical assistance was initiated in October 2016 by a national workshop held in Accra. 

Based on feedback and discussions from stakeholder consultations and a Needs Assessment 

report prepared to present the objectives and requirements for the technical assistance, the 

recommendations have then been taken into consideration to draft a more detailed description 

of the proposed outcome in the Technology specification report delivered in February 2017. 

Based on the outlined requirement the Drought Monitoring and Early warning system for Ghana 

has been developed and a first version was presented at the second the national workshop held 

in Accra in October 2017. This was the opportunity to give insight into the developed system and 

get feedback from the key stakeholders. 

Following this workshop, the main applicant (Water Resources Commission, WRC) has carried 

out a thorough review of the system followed by a validation of the performance of the portal. 

Methodology of the validation of the technical outcomes has been detailed as part of Activity 2.1 

(Methodology for validation and testing). The outcomes of the review and validation processes 

have been described in the Technology Validation report delivered in January 2018. 

2 Introduction 

The overall objective is the development and implementation of a drought early warning 

system facilitating the provision of timely and effective information related to the water and 

agriculture sectors allowing these sectors to take actions to mitigate impacts of upcoming 

droughts. The established drought early warning system is a web-based allowing relevant 

stakeholders to utilize the system without the installation of any software. The technical design 

of the system is based on the feedback from the national workshop and the stakeholder 

consultation meetings during the initial part of the technical assistance. 

The drought early warning system enables decision makers and stakeholders to use the 

transferred knowledge, practices and technologies actively in the dry season planning. The 

solution focuses on improving the adaptation to upcoming drought events by supporting 

elements within the risk management part of the drought management process. The crisis 

management or the response to an already occurred drought event or disaster will not as such 

be included in the outcomes of the CTCN assistance. 

The  Web-based drought early warning and forecasting portal covers the following main topics: 

 Issue analysis  

 Web-based drought early warning and forecasting portal providing access to the 

technical functionalities, and enable stakeholders to view and download data and 

information; 

 Data and information to avail near real-time satellite products related to drought 

warning and forecasting, and provide the required data input for the drought warning 

and forecasting system  
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 Risk management components supporting the risk-based drought management 

through drought early warning and detection for increased adaptation and preparedness 

to upcoming drought events 

 Dissemination relating to how the technical information is conveyed from the web-

based system to the end-users in form of reports, messages or warnings. 

3 User guide 

3.1 Core components of the portal 

The main output from the CTCN assistance is the Drought Early Warning and Forecasting 

Portal, which is accessible through the following link: www.flooddroughtmonitor.com.  

The web-based portal contains a number of web applications assisting the user within drought 

management and drought early warning. 

Introduction to the Drought Early Warning and Forecasting Portal, see Figure 1.  

 

 

Figure 1 The Drought Early Warning and Forecasting Portal developed as part of the CTCN assistance 

(www.flooddroughtmonitor.com)  

3.1.1 Registration and login 

All stakeholders in Ghana will be able to register to the Drought Early Warning and Forecasting 

Portal by registering as a new user on the web site. There will be unlimited and free access to all 

stakeholders from Ghana.  

http://www.flooddroughtmonitor.com/
http://www.flooddroughtmonitor.com/


 

 

    

 
   

  

  

  

 8 

3.1.1.1 Registration 
The registration page can be accessed from this direct link 

http://www.flooddroughtmonitor.com/home?register=true&ug=CTCN 

Alternatively, users can connect to http://www.flooddroughtmonitor.com, and under Login page 

select the registration as follows: 

 

Figure 2 Registration page of the portal 

In the registration page, user have to fill in their detailed information.  

 

Figure 3 User registration page 

http://www.flooddroughtmonitor.com/home?register=true&ug=CTCN
http://www.flooddroughtmonitor.com/
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3.1.1.2 Login 
All user have a unique username associated to a password, which is used when logging to the 

portal. 

 

Figure 4 User login page 

A password recovery function allows the user to receive his/her own password by email. 

3.1.2 Support 

Several means of support tools are available within the portal: 

 User guide: this user guide is made available as PDF for online viewing and also in a 

print-friendly version 

 Training material: all the training material are accessible directly from the home page 

 Knowledge portal: this discussion forum allows all users to interact together and with 

the administrator of the system to post question or comment. 

3.1.2.1 Access to this user guide 
User guides are available through the main landing page – see the location to access it in Figure 

5. 
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Figure 5 Access to user guide 

3.1.2.2 Training material 
The material used during the training courses consist of technical exercises and step-by-step 

guides. It is made available for viewing and can be accessed directly from the landing page of 

the portal - Figure 6 

 

Figure 6 Training exercises 

3.1.2.3 Knowledge portal 
The Knowledge Portal, accessible from the web portal, allows users to share knowledge and 

experience within drought management and drought early warning in Ghana. Users are able to 

post a question, which will be visible for the other users in the system as well as being able to 

read previous postings by users.   
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Figure 7 Knowledge Portal allowing users to share knowledge and experience 

3.1.3 Applications 

The Drought Early Warning and Forecasting Portal contains a number of applications all tailored 

to support the users within drought management and drought early warning. Each application is 

described in details to the participants through separate sessions. The available applications 

are: 

 Issue Analysis – Identify and prioritize the key environmental impacts from drought 

using a CCA and WRIAM approach 

 Water Indicator – Identify relevant indicators for measuring the state of the causes for 

drought in Ghana 

 Data and Information – Overview, understand and access available near real time data 

for drought assessment in Ghana 

 Drought Assessment – Understand and implement workflow for drought early warning 

in Ghana 

  Reporting – Access relevant status reports or bulletins regarding drought status in 

Ghana 

 

3.2 Issue Analysis 

3.2.1 Background 

The Issue Analysis application aims at analysing environmental issues and the causes behind 

the impacts from the environmental issues. The application is based on the Causal Chain 

Analysis (CCA) method and the Water Resource Issues Assessment Method (WRIAM).  

The key objectives with the application is to: 

1. Evaluate the key issues and assess the causes behind the associated environmental 

impacts 

2. Prioritise the environmental impacts based on a rapid assessment (WRIAM) 



 

 

    

 
   

  

  

  

 12 

The Issue Analysis application is intended for a workshop setting supporting the following 

outcomes: 

 Understand the causes behind specific issues 

 Able to target the planning towards the “deeper” causes 

 Increase the efficiency of the planning process 

3.2.1.1 Background to Causal Chain Analysis 
Causal Chain Analysis (CCA), often also called Root Cause Analysis is closely related to 

systems thinking and the DPSIR approach.  

At its most basic, a causal chain is an ordered sequence of events linking the causes of a 

problem with its effects. Each link in the causal chain is created by repeatedly answering the 

question Why? A simple schematic showing the major components of a CCA is shown below. 

 

 

Figure 8 Main components of a CCA 

 

Immediate Cause 
Immediate or technical causes (sometimes known as primary causes) are usually the direct 

technical causes of the problem. They are predominantly tangible (e.g. enhanced nutrient 

inputs), and with distinct areas of impact (with the exception of causes such as atmospheric 

deposition or climate change).  

Immediate causes, usually being technical in nature are the most straightforward to quantify, 

prioritise and geographically locate using maps. 

Underlying Cause 
Underlying causes are those that contribute to the immediate causes. They can broadly be 

defined as underlying resource uses and practices, and their related social and economic 

causes. Governance related causes are often identified here.  

Resource uses and practices will tend to fall into areas such as: 

 Land uses (reclamation/drainage operations, deforestation, agriculture etc.) 
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 Damaging or unsustainable practices (intensive livestock production, lack of treatment 

technology etc.) 

 Uses of water (diversion, storage etc.) 

 Lack of investment, operation and maintenance 

 Poor awareness or education 

 Governance failures, legislation, regulation or enforcement 

 

Root Cause 
Root causes are linked to the underlying social and economic causes and sectoral pressures 

but they are often related to fundamental aspects of macro-economy, demography, consumption 

patterns, environmental values, and access to information and democratic processes. Many of 

these may be beyond the scope of project interventions, but it is important to document them for 

two reasons:  

1. Some proposed solutions might be unworkable if the root causes of the problem are 

overwhelming.  

2. Actions taken nearer to the root causes are more likely to have a lasting impact on the 

problem 

Root causes can be divided into the following categories: 

 Climate change 

 Population pressure and demographic change 

 Poverty, wealth and inequality 

 National, regional and international governance issues 

 Education and formulation of values 

 Social change and development biases 

 Development models and national macro-economic policies 

3.2.1.2 Background to WRIAM 
The Water Resource Issues Assessment Method (WRIAM) has been conceived to allow the 

allocation of reasonably qualified, quantitative values to subjective judgements of the water 

resource issues, thus offering an evaluation of a given issue, which can be used for comparison 

with other issues and a record that can be re-assessed in the future. 

The method is based on a standard definition of the important assessment criteria as well as the 

means, by which semi-quantitative values for each of these criteria can be assigned, with the 

aim of giving a precise and independent score for each issue. 

The important assessment criteria fall into two groups: 

 (A) Criteria related to the importance of the issue or effect, and which can individually 

change the score obtained considerably; 
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 (B) Criteria that are of value to the given situation, but individually have a lesser effect 

on the score obtained. 

For group A, the overall scoring system was based on multiplying the scores allocated to each 

criterion. The principle of the multiplication is very important since it ensures that the weight of 

each score is expressed, whereas a summation of the scores could give identical results for 

groups of different scores.  

Group A contains the following components:  

 Extent of the impact (4 to 0): Transboundary, national, regional, local to no importance 

 Seriousness of the impact (3 to 0): Major change, significant change, negative 

change to no change 

For group B, the scoring system consists of adding the scores allotted to each criterion. This 

ensures that an individual score cannot influence the overall result very much. On the other 

hand, the summation ensures that the collective importance of all scores in group B is taken fully 

into account. 

Group B contains the following components: 

 Permanence (3 to 1): Permanent, temporary to no change 

 Irreversibility (3 to 1): Irreversible, reversible to no change 

 Cumulative character (3 to 1): Strong, moderate to light 

 

For each issue, the score representing the importance of the issue is calculated as follows: 

𝐒𝐜𝐨𝐫𝐞 = (𝐸𝑥𝑡𝑒𝑛𝑡 × 𝑆𝑒𝑟𝑖𝑜𝑢𝑠𝑛𝑒𝑠𝑠) × (𝑃𝑒𝑟𝑚𝑎𝑛𝑒𝑛𝑐𝑒 + 𝐼𝑟𝑟𝑒𝑣𝑒𝑟𝑠𝑖𝑏𝑖𝑙𝑖𝑡𝑦 + 𝐶𝑢𝑚𝑢𝑙.  𝑐ℎ𝑎𝑟𝑎𝑐𝑡𝑒𝑟) 
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Figure 9 Main functionality in the Issue Analysis application 
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3.2.2 Quick guide for first time user 

This section contains a brief introduction of the Issue Analysis application for first time users. For 

a more detailed description, see Annex A.  

3.2.2.1 Access the Issue Analysis application 
The Issue Analysis app is accessible from the landing page by clicking on the icon “Issue 

Analysis”. 

 

 

Figure 10 Issue Analysis application on the landing page 

 

3.2.2.2 Overview or open an Issue 
Click on “Overview” to view all the available Issues, the associated immediate impacts and the 

results of the rapid assessment. Click on an issue to open the connected Issue Analysis.  



 

 

    

 
   

  

  

  

 17 

 

Figure 11 Overview available Issues 

3.2.2.3 Add Issue Analysis 
Add a new Issue Analysis by clicking on the “Add” menu. This will open a dialog allowing the 

user to specify the parameters for the Issue Analysis. The following parameters are needed: 

 Immediate impact: Describe the immediate impact 

 Immediate cause: Describe the immediate cause 

 Underlying cause: Describe the underlying cause 

 Root cause: Describe the root cause 

 Extent: Extent of the impact. Note that no impact will set group A score to zero. 

 Seriousness: Seriousness of impact. Note that no change will set group A score to 

zero. 

 Permanence: Specify if the impact is permanent or not 

 Irreversibility: Specify if the impact if reversible or not. 

 Cumulative character: Specify if the impact is cumulative or not 

 Level of documentation: Specify the level of documentation. Please note that this is 

not included in the assessment.  
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Figure 12 Add Issue Analysis 
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3.3 Water Indicators 

3.3.1 Background 

The main objective for indicators is to enable or promote information exchange regarding the 

issue they address. An example of a simple indicator and often used indicator is our body 

temperature to monitor our health.  

 

Figure 13 Indicator example 

Based on the state (the patient is fine or has a fever), you can decide what action to take to 

improve the situation (e.g. go to the hospital, take medicine, do nothing). 

Water indicators can be used to understand the current state of water resources, the changes in 

these resources and whether or not interventions in a river basin produce the desired effect (e.g. 

reducing the number of people affected by flooding). The results from gathering information 

around a specific indicator can be both in the form of maps and graphs. 

Although indicators are critical to understand what is happening in a system (river basin, water 

supply system, etc.), there are a large number (literally thousands) and information is often not 

complete. Furthermore, it should be noted, that ideal indicators may not be practical; the 

feasibility of using certain indicators can be constrained by the availability of data and financial 

and human resources.  

A useful indicator should be: 

 relevant for monitoring the state or the pressure of the issue 

 easy to interpret 

 able to give information on the current status and the status in relation to the historical 

change 

 based on available data or information 

Also, the more defined an indicator is, the less room there will be for later confusion or 

complications. 

The Water Indicator application which has been developed as part of the Flood and Drought 

Management Tools project can help users identify water related indicators to understand the 

current state of water resources, the changes in these resources and whether or not 

interventions produce the desired effect. 

The application provides the following support:  

 Assists user in selecting relevant indicators based on a specific issue 

 Used as a learning tool for basin or catchment organisations/other users 

http://fdmt.iwlearn.org/
http://fdmt.iwlearn.org/
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 Provides a starting point through a default indicator framework that can be adjusted and 

complemented to match user needs 

 Provides an online tool for stakeholders to share their indicator frameworks with others 

to allow for consistency (it helps if you are all measuring the same thing) 

 Used as a tool for storing indicator information to support the design of decision support 

systems (DSS). 

 

 

Figure 14 Example of default framework for river basin planning 
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3.3.2 Quick guide for first time user 

This section contains a brief introduction to the Water Indicator application for first time users. 

For a more detailed description, see Annex B.  

3.3.2.1 Access the Water Indicator application 
The Water Indicator app is accessible from the landing page by clicking on the icon “Water 

Indicator”.  

 

Figure 15 Water Indicator application on the landing page 

3.3.2.2 Key content 
The Water Indicator application is based on Indicators and Indicator Frameworks. 

Indicator 
The Water Indicator application contains a large number of indicators or descriptions of 

indicators. The Indicators are described using the following items (see Figure 20): 

 Name: Name of the indicator 

 User: user creating or uploading the indicator 

 Description: brief description of the indicator 

 Keywords: keywords or tags describing the use of the indicator. Keywords are used to 

search for indicators 

 Metadata sheet: pdf document containing a detailed description of the indicator 

Indicator Framework 
An Indicator Framework is a tabular description of the linkage between environmental issues 

and indicators used to monitor the state of the issues. The environmental issues are divided into 

main and sub-groups. The Water Indicator application contains a number of default Indicator 
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Frameworks, available for all users, and users are also able to create their own Indicator 

Frameworks (see Figure 19). 

3.3.2.3 View Indicator Framework 
Existing Indicator Frameworks are available using the “Open” menu in the Framework tab. The 

“Open” menu will list all Indicator Frameworks available for the current user. Note that 

Frameworks with a “*” are default Indicator Frameworks (view and clone for all users). 

 

Figure 16 Open available indicator frameworks 

3.3.2.4 View Indicator sheet 
Indicator sheets or metadata sheets are available by i) clicking on the indicator in the Indicator 

Framework or ii) by clicking on the metadata sheet in the indicator list (in the Indicator tab). 

 

Figure 17 Open indicator sheet 

3.3.2.5 Search for indicator 
The user is able to search for indicators in the following way: 
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 Indicator tab: type a search name in the search box and click “search”. The search will 

use the keywords and all indicators containing the search item in the keywords will 

appear. 

 Indicator tab: Click on a keyword to view all indicators containing the same keyword 

 Framework tab: Open an indicator and click on a keyword. This will open the Indicator 

tab and list all indicators containing the same keyword. 

 

 

Figure 18 Search for indicator 
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Figure 19 Main functionality in the Framework tab 
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Figure 20 Main functionality in the Indicator tab 

 



 

 

    

 
   

  

  

  

 26 

3.4 Data and Information 

3.4.1 Background 

This section contains a brief introduction to the Data and Information application for first 

time users. For a more detailed description see Annex C, where the specific data types 

are described in details. 

3.4.2 Quick guide for first time user 

3.4.2.1 Access the Data and Information application 
The Data and Information app is accessible from the landing page by clicking on the icon 

“Data and Information”. 

 

Figure 21 Data and Information application on the landing page 

3.4.2.2 Select data to view or analyse 
Once you have logged in, the available data types are listed in the Select menu. Open 

the Select menu to select, which should be made available (this selection can be 

changed later on). 
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Figure 22 Select menu  

The selected data will be available for viewing, download and analysis. Note that it is 

ONLY the data selected in the Select menu that are available for further processing.  

See section Annex C for a detailed description of the available data. 

 

 

Figure 23 Selection the favourite data to work with 

3.4.2.3 View data 
The selected data could be viewed from the Data tab, which allows you to view each time 

step of a selected data type.  
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Figure 24 View data from the Layer menu 

3.4.2.4 Download data as netcdf files 
The tools menu is used to download and process the selected data. Use the tool called 

“Raster file to download any of the available data files as a netcdf file. To download a 

data file: 

 Select the layer you would like to download data from 

 Select the Raster File under the Tools section 

 Specify the period and press Download 

 Then on the following dialog showing the file size, and the file name, press 

Download. 
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Figure 25 Download data as netcdf files 

Note: the zip file contains the raster as .nc file, which can be open in most GIS tools. In 

addition, a legend file as .qml are associated to the .nc file. This legend file can be used 

in QGIS to load the default symbology. 

3.4.2.5 View or download time series 
The tools menu contains a number of different options for processing and analysing the 

selected data types. Data can be extracted at different spatial resolutions from the entire 

focus area to point locations, and can be presented as time series, envelope plots or 

chart plots.  

 

Figure 26 View or download time series  
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3.5 Drought Assessment 

3.5.1 Background 

Drought early warning systems are an important component of the risk management part 

of the drought management process as highlighted in Figure 27. It provides an 

identification of a current or upcoming hazard and provides an assessment of the 

associated risk related to the hazards.  

The main objective of a drought early warning system is to detect when and if a drought 

hazard might occur and the location and severity of the hazard. Drought warnings could 

be expressed based on the hazard itself or on the associated risk towards specific 

vulnerable sectors or areas.  

 

 

Figure 27 Drought management (adapted from (Center National Drought Mitigation, u.d.)) 

The identification of the timing and location of a drought event is the first step in a drought 

assessment or drought management process. The impact assessment aims at 

quantifying how the identified hazards affect specific areas or sectors exposed to this 

hazard. 

The vulnerability analysis provides a mean for analysing the causes behind the drought 

impact and the priority of these causes. This is an important step for increasing the 

effectiveness of drought risk management as it provides the means for drought 

interventions or mitigations measures to be targeted specifically against the underlying 

causes for the drought impact. 

The risk is expressed based on the vulnerability towards the impact from a specific 

hazard, or as the likelihood of harm, loss or disaster for a specific drought related hazard 

(see illustration in Figure 28). 
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Figure 28 Risk assessment workflow 

3.5.1.1 Hazard identification 
The identification of the timing and location of a drought event is the first step in a drought 

assessment or drought management process. It is typically based on different types of 

drought indices each representing the state of a specific drought related issue at different 

times. Drought indices could cover the entire spectrum of drought types: meteorological, 

agricultural and hydrological drought (see Figure 29). 

 

Figure 29 Different types of drought indices 

An example could be climate based drought indices describing the state of 

meteorological drought. The specific drought indices to be included should be based on 

locally accepted indices as well as scientific sound and validated indices.  

Examples of drought indices: 

 Rainfall deviation expressed through the standardized precipitation index (SPI), 
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 Crop related drought hazard described through the vegetation condition index 

(VCI). 

The key requirement is that the indices should represent the current or future state, 

hence should be available in close to real time or as forecasted values. Spatially 

distributed indices are often a requirement as well, as the location of the drought hazard 

is critical. Exceptions would be indices related to specific locations as reservoirs, lakes, 

rivers etc. 

3.5.1.2 Exposure 
The exposure to drought relates to the identification of sectors or areas particularly 

sensitive to drought through impacts or consequences such as reduced crop yield, 

livestock losses, socio-economic impacts or reservoir depletion. Examples of areas 

exposed to drought could be rainfed agricultural areas or urban areas relying on surface 

water resources. The exposure would often be illustrated in the form of GIS shape files or 

raster maps delineating areas of specific exposure. 

3.5.1.3 Hazard categories 
In order to express the severity of the drought hazard, drought categories are often used 

to classify the severity and impact of the hazard.  The classification for drought categories 

could be inspired from the US drought monitor system using drought categories from D0 

(abnormally dry) to D4 (Exceptional drought) (for more information see Figure 30).  

 

Figure 30 Drought classification scheme (National Drought Mitigation Center, u.d.) 

3.5.1.4 Impact assessment 
The impact assessment aims at quantifying how the identified hazards affects specific 

areas or sectors exposed to this hazard. The outcome will describe how specific drought 

related hazards impact e.g. the agricultural production or the water supply. Impact could 

be expressed in terms of direct losses, or changes but also in terms of hazard or drought 

categories within a specific exposed area. 

A typical way to illustrate the drought impact is through the use of drought categories 

where the areas within specific drought categories are calculated and presented in tables. 

The impact would be divided into exposed categories, e.g. rainfed areas, urban areas etc. 
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The correlation between drought categories and specific impacts would often be 

assessed through a regression analysis looking at the correlation between past drought 

events and the impact. 

3.5.1.5 Risk analysis 
The risk will be expressed based on the vulnerability towards the impact from a specific 

hazard, or as the likelihood of harm, loss or disaster for a specific drought related hazard.  

Risk is defined as the likelihood of harmful consequences, or expected losses (deaths, 

injuries, property, livelihoods, economic activity disrupted or environment damaged) 

resulting from interactions between natural or human-induced hazards and vulnerable 

conditions (UN-ISDR, 2009, EC, 2011). The risk analysis will identify areas or groups at 

different risk levels, which will be the targets for the following adaptation or mitigation 

planning.  

Risk is often expressed as hazard x vulnerability.  

3.5.2 Quick guide for first time user 

This section contains a brief introduction for first time users. For a more detailed 

description, see Annex D.  

3.5.2.1 Access to the Drought Assessment application 
The Drought assessment app is accessible from the landing page by clicking on the 

“Drought assessment” icon. 

 

Figure 31 Drought Assessment application on the landing page 

3.5.2.2 Main content 
The Drought Assessment app is a map based application, which has two main menus: 

 Drought Warning 
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 Drought Risk 

Drought Warning 
The Drought Warning page allows the user to select a specific layer and apply a 

threshold value to highlight the areas that are affected by a specific hazard. 

 

Figure 32 Drought Warning page of the Drought Assessment app 

Warnings: The selection of layer is 

done by clicking on the Warning button. 

The selected layers will then appear in 

the tree view. It is always possible to 

edit them later.  

Edit: This is to edit the user-defined 

warning level. The Edit button is used 

to edit the threshold value as well as 

the comparison type to be applied on 

the hazard. The maps is 

instantaneously updated. 

View original: This allows the user to 

view on the map the original hazard 

layer without applying any warning 

level. 
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Drought Risk 
The drought risk page provides an interface to assess risk based on hazards and 

vulnerability. The main output of this page is a map with overlaid hazard and vulnerability. 

 

Figure 33 Drought Risk page of the Drought Assessment application 

 

Hazards: 

 Layer: layers for the hazard can 

be selected from a list. 

 Legend: the user is able to edit 

the color code and values in the 

legend  

Vulnerabilities:  

 Layer: layers for the 

vulnerabilities can be selected 

from a list. 

 Legend: the user is able to edit 

the color code and values in the 

legend 
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3.6 Reporting 

3.6.1 Background 

Dissemination in the form of reports or bulletins are critical in relation to planning as this 

enables the decision or policy makers to disseminate the actual plans or the background 

for the decision process to stakeholders. The content and format of the dissemination 

depends to a large extent on the specific content of the decision and the intended 

receiver of the report or bulletin. In some cases the reports or bulletins need to be very 

detailed with technical content and in other cases it should highlight the key issues using 

non-technical terms. For this reason the reporting application is based on a process 

allowing the user to select between a number of default reports, or develop their own 

reports based on the specific requirements. 

The reporting application is based on reporting templates (Word documents) containing a 

number of tags, where the user is able to specify which type of content the reporting 

application should replace the tags with. Currently the tags could be replaced with 

images, text, charts or tables. 

 

 

Figure 34 Template report with tags and final report with input in the form of images, chart or text 

replacing the tags 

3.6.1.1 Template reports and tags 
Template reports are one of the key features in the Reporting application. A template 

report is a Word document (docx file) containing the overall framework of the report. The 

Reporting application is able to insert objects in the form of images, text, chart or tables at 

user specified locations in the template report, and converting the template report into a 

final report containing for example tables with the latest climate information, drought 

hazards or other information from the Flood and Drought Portal.  
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The location of the inserted objects (images, text, chart or tables) are specified by adding 

tags in the report, where a tag is specified by brackets (start and end bracket) with a text 

in between, e.g. “{this is a reporting tag}”. See Figure 35 for an example of a reporting 

template with reporting tags.  

 

Figure 35 Example of a template reports with reporting tags 

When loading the reporting template in the Reporting application, all tags are listed and 

the user is able to specify what the reporting application should insert instead of each tag 

(images, text, chart or tables). See Figure 36 for an example. 

 

 

Figure 36 Example of how tags are converted to reporting objects within the Reporting application 
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3.6.1.2 Automated reporting 
Another feature of the Reporting application is the ability of generating reports 

automatically based on a user-defined schedule. Reports will be generated automatically 

– without any user action – based on the latest data available. A notification email will 

also be sent to all the recipients of the report. The email will contain a link to download 

the latest version of the report. 

 

Figure 37 Example of an email notification when a new report has been generated. 

3.6.2 Quick guide for first time user 

This section contains a brief introduction for first time users. For a more detailed 

description, see Annex E.  

This section explains how to use one of the default reporting templates built in to the 

system. For description on how to make a new report or upload user specific content, 

please refer to the following sections. 

3.6.2.1 Access the Reporting application 
The reporting application is available from the landing page by clicking on the icon 

“Reporting”, see Figure 38. The reporting application will use the workgroup concept to 

determine which reports are available for viewing, editing and download.  
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Figure 38 Open the Reporting application on the landing page 

3.6.2.2 Default reporting templates 
The Reporting application contains a number of built in default reporting templates 

enabling the user generate reports with a default content without having to develop their 

own Word based template. The default templates could also be used as a starting point 

for a user defined report.  

The default reporting templates are accessed through the “Open” menu, where the all the 

default templates are marked with a “*” in from of the name, see Figure 39. Please note 

the following: 

 Default reporting templates are all developed by the system and are available as 

read-only templates (user needs to clone the template to use them). 

 “Generate” option is disabled 

In order to use a default reporting template within a specific basin please follow the 

following procedure: 

 Select a default reporting template (through the “Open” menu”) 

 Clone the reporting template 

o Specify a name for the cloned version 

o Specify the workgroup for the cloned version of the report 

o Update the description if needed 

 Press “Clone” to copy the default reporting template. 

After the reporting template is cloned the “Generate” option will be enabled and the user 

can generate the report for this specific basin. The report will be populated with updated 

content and can be viewed after the “Generate” option is executed. 
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Figure 39 Default reporting templates 

Main option to manage the reports are as follow: 

 

When working with a report, there are a few options available: 

 

3.6.2.3 View or edit content 
When opening a report with editing rights, refer to user workgroup, all the content of the 

reporting template will be editable. When pressing the edit button ( ) an Edit dialog is 

opened and the user is able to specify the content for the specific tag. Pressing the 

preview button ( ) enables the user to preview the content of the specific tag. 
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Figure 40 Edit reporting content 

3.6.2.4 Generate report 
The “Generate” menu generates the report by inserting all the user specified content into 

the reporting template and converting the report to pdf format. A dialog will appear at the 

end of the process allowing the user to download the generated report. 

 

3.6.2.5 Download report 
The “Download” menu enables the user to download an already generated report. Note 

that the report is not updated when using this option. 

3.6.2.6 Copy link to report 
The “Copy link” function provides a link to report. The link is automatically copied to the 

clipboard and can be used to access the generated report. The link can be used to share 

the report. Note: it is not needed to login to the Portal to access the report via this link. 
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APPENDICES 
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1 Annex A: Issue Analysis 

This section contains a description of the functionalities in the Issue Analysis application.  

1.1 Overview or Open Issues 

Click on “Overview” to view all the available Issues, the associated immediate impacts 

and the results of the rapid assessment. Click on an issue to open the connected Issue 

Analysis.  

 

Figure A-1 Overview available Issues 

1.2 New Issue 

Opens a dialog allowing the user to specify the name of the issue and a description. 

Press “Add” to generate a new Issue. Please note that a new Issue always will be located 

in the current workgroup. 

 

Figure A-2 Add new Issue 

1.3 Clone Issue 

Enables the user to clone an issue by specifying a new name and the workgroup which 

the cloned issue should be located in.  
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Figure A-3 Clone issue 

1.4 Copy Issue 

Enables the user to copy the environmental impacts from one issue to another existing 

issue. The environmental impacts will be added to the existing issue (selected in the 

“Copy” dialog). Please note that this requires an existing issue created by the current 

user.  

 

Figure A-4 Copy issue 

1.5 Edit Issue 

Enables the user to edit the name and description of the issue. Only enabled for authors 

of the specific issue. 

1.6 Delete Issue 

Enables the user to delete an Issue. Only enabled for authors of the specific issue. 

1.7 Add Issue Analysis 

Add a new Issue Analysis by clicking on the “Add” menu. This will open a dialog allowing 

the user to specify the parameters for the Issue Analysis. The following parameters are 

needed: 



 

 

    

 
   

  

  

  

 45 

 Immediate impact: Describe the immediate impact 

 Immediate cause: Describe the immediate cause 

 Underlying cause: Describe the underlying cause 

 Root cause: Describe the root cause 

 Extent: Extent of the impact. Note that no impact will set group A score to zero. 

 Seriousness: Seriousness of impact. Note that no change will set group A score 

to zero. 

 Permanence: Specify if the impact is permanent or not 

 Irreversibility: Specify if the impact if reversible or not. 

 Cumulative character: Specify if the impact is cumulative or not 

 Level of documentation: Specify the level of documentation. Please note that 

this is not included in the assessment.  

 

 

Figure A-5 Add Issue Analysis 

Note that the assessment score is not calculated before the “Update” button is pressed. 

1.8 Edit Issue Analysis 

Opens the Issue Analysis dialog allowing the user to edit the Issue Analysis. This 

requires that the user is the author of the Issue. 
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Figure A-6 Edit Issue Analysis icon 

1.9 Delete Issue Analysis 

Deletes a specific Issue Analysis. This requires that the user is the author of the Issue. 

 

Figure A-7 Delete Issue Analysis icon 
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2 Annex B: Water Indicator 

This section contains a description of all the functionalities in the Water Indicator 

application. 

2.1 Framework tab 

The Framework tab is the main tab and provides access to the Indicator Frameworks and 

the individual indicator descriptions. The following section contains a brief description of 

all the functionality within the Framework tab. 

2.1.1 Open Indicator Framework 

Open all the available Indicator Frameworks. The user is able to view the following 

Indicator Frameworks: 

 Default Indicator Frameworks: these are marked with a “*” and are available for 

all users. The default Indicator Frameworks can be viewed or cloned by all users. 

Only the administrator is able to delete or edit the default Indicator Frameworks. 

 All Frameworks developed by the same user will be available 

 All Frameworks available within the current workgroup will be available 

2.1.2 New Indicator Framework 

Developing a new Indicator Framework requires the following steps: 

 Press “New” to open a dialog to specify the name and description for the 

Indicator Framework.  

 Press “Add” the generate the Indicator Framework 

Please Note the new Indicator Framework will be located in the current workgroup. 

 

Figure B-1 New Indicator Framework 
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The Indicator Framework tab will now appear with a blank screen without any groups or 

indicators. To add groups and associated indicators follow these steps: 

 Add Main Indicator groups by pressing on the “+ Group” menu, specify the name 

of the indicator group and press “Add”. 

 

Figure B-2 Add main groups 

Edit the main groups by clicking on the group name, which will enable the below dialog. 

The user have the following options: 

 + Group: Add a sub-group 

 + Indicator: Add indicator. This will open the indicator list. The user should select 

the indicators to be added to the specific group and press “Add to Framework” 

 Rename: Rename the specific indicator group 

 Delete: Delete the specific indicator group. Note that this will also remove all sub-

groups and all associated indicators. 

 

 

Figure B-3 Main group editing options 

2.1.3 Clone Indicator Framework 

All users are able to clone an Indicator Framework. When cloning an Indicator 

Framework the user is prompted to specify a name for the new Indicator Framework, a 

description and the workgroup where the Indicator Framework is to be located in. 
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Figure B-4 Clone an Indicator Framework 

2.1.4 Delete Indicator Framework 

Delete the current Indicator Framework. Please note that the delete option is only 

available if the Indicator Framework is developed by the current user. For all other users 

the Delete option will be hidden.  

2.1.5 Main/sub- groups 

Indicator groups are used to store indicator descriptions. Each indicator group 

corresponds to an environmental issue. To rename, delete or add an indicator group 

please refer to section 2.1.2 

2.1.6 Indicator 

Indicators are available from the Indicator Framework. Clicking on an Indicator opens the 

Indicator metadata sheet, see Figure 17 or Figure B-6. 

 

Figure B-5 Indicator 

2.1.7 Indicator metadata sheet 

Clicking on an indicator opens the Indicator metadata sheet, see Figure B-6. The 

following functionality is available: 

 Keyword: list all the keywords for the current indicator. Clicking on a keyword 

opens the indicator list displaying all indicators with the same keyword. 

 Print: Prints the metadata sheet (pdf file) 

 Download: Download the metadata sheet (pdf file) 
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Figure B-6 Indicator metadata sheet 

2.2 Indicator tab 

The Indicator tab contains all the available indicators enabling the user to edit and delete 

their own indicators and clone indicators developed by other users. The following section 

contains a brief description of all the functionality within the Indicator tab. 

Please note that all indicators will be available for all users as the workgroup functionality 

is not applied to the indicators (the Indicator Framework is using the workgroup concept). 

2.2.1 New Indicator 

Press the “New” button to initiate the process for adding a new indicator. The “New” 

dialog appears, see Figure B-7. The user is prompted to specify the following information: 

 Indicator: Indicator name. Please note that the indicator name needs to be 

unique. 

 Description: Specify the description for the indicator. 
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 Keyword: Specify keywords connected to the indicator. Please note that 

keywords are separated by a “,”. 

 Metadata sheet: Click on “Select” to upload the metadata sheet for the indicator. 

Please note that the metadata sheet needs to be in pdf format. 

 Template: Press on “Template” to download an empty template for the metadata 

sheet. Remember to convert the metadata sheet to pdf before uploading it to the 

system.  

 

Figure B-7 New Indicator 

2.2.2 Search Indicators 

The user is able to search for indicators in the following way: 

 Indicator tab: type a search name in the search box and click “search”. The 

search will use the keywords and all indicators containing the search item in the 

keywords will appear. 

 Indicator tab: Click on a keyword to view all indicators containing the same 

keyword 

 Framework tab: Open an indicator and click on a keyword. This will open the 

Indicator tab and list all indicators containing the same keyword. 
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Figure B-8 Search for indicator 

2.2.3 All 

Clicking on the “All” menu displays all the available indicators.  

2.2.4 Clone Indicator 

Clone an indicator by pressing on the “Clone” icon, see Figure B-9.  

 

Figure B-9 Clone a specific indicator 

The user needs to specify the following information when cloning an indicator: 

 Indicator: Indicator name. Please note that the indicator name needs to be 

unique. 

 Description: The description from the original indicator is displayed, but the user 

is able to edit the description. 

 Keyword: The list of keywords from the original indicator is displayed, but the 

user is able to edit the list of keywords. Please note that keywords are separated 

by a “,”. 

 Metadata sheet: The original metadata sheet is shown, but the user have the 

option of uploading a new metadata sheet in the form of a pdf document. 

 

Figure B-10 Clone menu 
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2.2.5 Keywords 

The keywords are used to describe the indicator and is added by the user during the 

creation of the indicator. Keywords are also used by the indicator search as the search is 

using the indicator keywords. 

2.2.6 Metadata sheet 

The metadata sheet is a pdf document containing a detailed description of the indictor. 

The Metadata sheet is uploaded during creation of the indicator.  
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3 Annex C: Data and information 

3.1 Data description 

3.1.1 Rainfall related data 

3.1.1.1 TRMM 
The Tropical Rainfall Measuring Mission (TRMM) is the first Earth Science mission 

dedicated to studying tropical and subtropical rainfall. It is a joint mission between the 

National Aeronautics and Space Administration (NASA) and Japanese Aerospace 

Exploration Agency (JAXA) dedicated to monitor rainfall in the tropics through microwave 

and visible infrared sensors, including the first space-borne rain radar. By use of a low-

altitude orbit (350km), TRMM is complemented with state-of-the-art instruments providing 

high accurate measurements. 

TRMM is especially useful in cases where consistency in precipitation data is required 

over many years, such as the case for hydrological design, flood risk assessment and 

water resources management. 

Spatial extent From 50 degrees north to 50 degrees south of the equator 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.25 degree 

Temporal resolution: resampled to daily rainfall product from 2000 to 

present 

Reference http://trmm.gsfc.nasa.gov  

Data 

requirements 

and calculation 

The original 3-hourly real-time rainfall data in mm/h from NASA is 

resampled to a daily product in mm/day, this daily product is then 

downloaded from the TRMM data provider and disseminated via the 

portal. Negative values are removed during the processing. 

Update 

Frequency 

Daily  

Related indices SPI 1-month, SPI 3-month, etc 

Data source TRMM_3B42RT_Daily 

 

Based on TRMM rainfall dataset we will generate the indicators presented in the following 

tables. 

  

http://trmm.gsfc.nasa.gov/
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Title  Rainfall deviation (30 days) 

Description Deviation of accumulated rainfall from the long term mean within the last 30 days. 

Calculated based on the TRMM rainfall where the long term mean is based on 

TRMM data since 2000. 

 INDICATOR USAGE 

Index 

interpretation 

Used to locate areas with rainfall surplus or deficit within the last 30 days. 

Spatial extent As TRMM data 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.25 degree 

Temporal resolution: Updated daily as TRMM rainfall gets updated. 

Reference Processed based on TRMM data 

Example of 

usage 

Illustrates the how the accumulated rainfall deviates from the mean accumulation 

within a given area. Used to locate areas with rainfall surplus or deficit across the 

last 30 days. 

 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

Based on daily TRMM rainfall and calculated as TRMM - TRMMmean for the last 

30 days 

Update 

Frequency 

Daily updated in the web portal 

Related indices - 

Data source Based on TRMM data 
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Title  Effective Drought Index (EDI) 

Description The Effective Drought Index (EDI) was developed by Byun and Wilhite (1999) as a 

measure that considers daily water accumulation with a weighting function for time 

passage. More information is available via 

http://om.ciheam.org/om/pdf/a95/00801330.pdf 

 INDICATOR USAGE 

Index 

interpretation 

Used to locate areas that are very dry to very wet as a measure of drought. The 

"drought range" of the EDI indicates the following: 

extreme drought at EDI = -2, 

severe drought at -2.0 < EDI = -1.5 

moderate drought at -1.5 < EDI = -1.0.  

Near normal conditions are indicated by -1.0 < EDI = 1.0 

 

Spatial extent As TRMM data 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.25 degree 

Temporal resolution: Updated daily as TRMM rainfall gets updated. 

Reference Hi-Ryong Byun and Donald A. Wilhite, Objective Quantification of Drought Severity 
and Duration, 1999. 

http://journals.ametsoc.org/doi/full/10.1175/1520-

0442%281999%29012%3C2747%3AOQODSA%3E2.0.CO%3B2 

Example of 

usage 

Example of the EDI coverage for Ghana: 

 

 
 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

Based on daily TRMM rainfall and calculated for the last 30 days as: 

EDI = Deviation(PE)/Std(PE) 
 

Where PE is : 

http://om.ciheam.org/om/pdf/a95/00801330.pdf
http://journals.ametsoc.org/doi/full/10.1175/1520-0442%281999%29012%3C2747%3AOQODSA%3E2.0.CO%3B2
http://journals.ametsoc.org/doi/full/10.1175/1520-0442%281999%29012%3C2747%3AOQODSA%3E2.0.CO%3B2


 

 

    

 
   

  

  

  

 57 

 

Update 

Frequency 

Daily 

Related indices - 

Data source Based on TRMM data 
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Title  Standardised Precipitation index (SPI) 

Description The SPI is based on the probability of precipitation for any time scale. The 

probability of observed precipitation is then transformed into an index. It is 

being used in research or operational mode in more than 70 countries. More 

information is available via 

http://www.wamis.org/agm/pubs/SPI/WMO_1090_EN.pdf 

 INDICATOR USAGE 

Index 

interpretation 

SPI is typically categorized using the following classification: 

> 2 Extremely wet 

1.5 to 2 Very wet 

1 to 1.5 Moderately wet 

-1 to 1 Near normal 

-1.5 to -1 Moderately dry 

-2 to -1.5 Severely dry 

< -2 Extremely dry 

A drought event occurs any time the SPI is continuously negative and 

reaches an intensity of -1.0 or less. The event ends when the SPI becomes 

positive. Each drought event, therefore, has a duration defined by its 

beginning and end, and an intensity for each month that the event continues. 

The positive sum of the SPI for all the months within a drought event can be 

termed the drought’s “magnitude”. 

Because the SPI is normalized, wetter and drier climates can be represented 

in the same way; thus, wet periods can also be monitored using the SPI. 

However, it must be stressed that the SPI is not suitable for climate change 

analysis because temperature is not an input parameter. 

Spatial extent As TRMM data 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.25 degree 

Temporal resolution: Updated daily as TRMM rainfall gets updated. 

Reference http://www.wamis.org/agm/pubs/SPI/WMO_1090_EN.pdf 

Example of usage The following SPI products are available: 

 SPI -month: the one-month SPI provides a comparison of the 

precipitation over a specific one month period with the precipitation 

totals from the same period for all the years included in the historical 

record. 1-month SPI reflects relatively short-term conditions, its 

application can be related closely with short-term soil moisture and 

crop stress, especially during the growing season. 

 SPI 3-month: the three-month SPI provides a comparison of the 

precipitation over a specific 3-month period with the precipitation 

totals from the same 3-month period for all the years included in the 

historical record. A 3-month SPI reflects short- and medium-term 

moisture conditions and provides a seasonal estimation of 

precipitation. 

 SPI 6-month: the 6-month SPI compares the precipitation for that 
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period with the same 6-month period over the historical record. The 

6-month SPI indicates medium-term trends in precipitation. 

 INDICATOR CALCULATION 

Data requirements 

and calculation 

The original 3-hourly real-time rainfall data in mm/h from NASA is resampled 

to daily product in mm/day. Negative values are removed during the 

processing. 

Update Frequency Daily  

Related indices SPI 1-month, SPI 3-month, etc 

Data source TRMM 3B42RT 
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Title  Climatology or historical ensembles 

Description Climatology or historical ensembles is a way to generate ensembles based on the 

historical rainfall to be used as a “prediction” of how the future rainfall will evolve. 

Climatology is very useful if forecasted rainfall is not available or the skill of the 

forecasted rainfall is poor. 

 INDICATOR USAGE 

Index 

interpretation 

Provides ensemble input of forecasted rainfall based on the historical observations. 

Spatial extent From 50 degrees north to 50 degrees south of the equator (similar to TRMM data) 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.25 degree 

Temporal resolution: daily 

Reference TRMM data 

Example of 

usage 

Ensemble members used as climate input for hydrological, water resource or crop 

models for evaluation of a future situation. These can also be used to produce 

statistical monthly envelope charts as shown below. 

 

 INDICATOR CALCULATION 

Data 

requirements 

and 

calculation 

Based on TRMM data from 2000 until today. Climatology is yearly time series of the 

historical TRMM rainfall.  

Update 

Frequency 

Daily 

Related 

indices 

SPI 1-month, SPI 3-month, etc. based on forecasted rainfall 

Data source TRMM data 
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3.1.1.2 GPM 
The Global Precipitation Measurement (GPM) mission is an international network of 

satellites that provide the next-generation global observations of rain and snow.  

GPM, initiated by NASA and the Japan Aerospace Exploration Agency (JAXA) as a 

global successor to TRMM, comprises a consortium of international space agencies. 

 

Spatial extent Spanning 50°S-50°N (and all longitudes) 

Spatial and temporal 

resolution 

Spatial resolution: 0.1 degree 

Temporal resolution: daily rainfall product starting in 2014 

to near-present 

Reference https://pmm.nasa.gov/GPM  

Data requirements and 

calculation 

No processing of the data is required 

Update Frequency Daily  

Related indices None 

Data source https://pmm.nasa.gov/GPM  

 

3.1.1.3 CHIRPS 
Climate Hazards Group InfraRed Precipitation with Station data (CHIRPS) is a 30+ year 

quasi-global rainfall dataset. CHIRPS incorporates 0.05° resolution satellite imagery with 

in-situ station data to create gridded rainfall time series for trend analysis and seasonal 

drought monitoring.  

Spatial extent Spanning 50°S-50°N (and all longitudes) 

Spatial and temporal 

resolution 

Spatial resolution: 0.05 degree 

Temporal resolution: daily rainfall product starting in 1981 

to near-present 

Reference http://chg.geog.ucsb.edu/data/chirps/ 

Data requirements and 

calculation 

No processing of the data is required 

Update Frequency Monthly  

Related indices None 

Data source version 2.0 of CHIRPS, read more at 

http://chg.geog.ucsb.edu/data/chirps/ 

 

https://pmm.nasa.gov/GPM
https://pmm.nasa.gov/GPM
http://chg.geog.ucsb.edu/data/chirps/
http://chg.geog.ucsb.edu/data/chirps/
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3.1.1.4 CRU 
Datasets are month-by-month variation in climate over the last century or so as produced 

by the Climatic Research Unit (CRU) at the University of East Anglia. These are 

calculated on high-resolution (0.5x0.5 degree) grids, which are based on an archive of 

monthly means provided by more than 4000 weather stations distributed around the 

world. 

This dataset provides a long record of historical rainfall data based on weather stations. 

Spatial extent All land areas (excluding Antarctica) 

Spatial and temporal resolution Spatial resolution: 0.5° resolution 

Temporal resolution: monthly (period 1901-2013) 

Reference https://crudata.uea.ac.uk/cru/data/hrg/#info 

Data requirements and calculation No processing of the data is required 

Update Frequency None  

Related indices None 

Data source https://crudata.uea.ac.uk/cru/data/hrg/#info 

 

3.1.1.5 PERSIANN-CCS 
PERSIANN-Cloud Classification System (PERSIANN-CCS) is a real-time global high-

resolution satellite precipitation product developed by the Center for Hydrometeorology 

and Remote Sensing (CHRS) at the University of California, Irvine (UCI). PERSIANN-

CCS system enables the categorization of cloud-patch features based on cloud height, 

areal extent, and variability of texture estimated from satellite imagery.  

Spatial extent 60 deg S to 60 deg N 

Spatial and temporal 

resolution 

Spatial resolution: 0.04 deg x 0.04 deg or 4km x 4km 

Temporal resolution: daily (January 2003 - Present) 

Reference http://chrsdata.eng.uci.edu  

Data requirements and 

calculation 

Resampled to daily rainfall product 

Update Frequency Daily  

Related indices None 

Data source 
ftp://persiann.eng.uci.edu/CHRSdata/PERSIANN/daily 

 

https://crudata.uea.ac.uk/cru/data/hrg/#info
https://crudata.uea.ac.uk/cru/data/hrg/#info
http://chrsdata.eng.uci.edu/
ftp://persiann.eng.uci.edu/CHRSdata/PERSIANN/daily
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3.1.2 Seasonal forecasts 

The Climate Forecast System (CFS) version 2 is run by the Environmental Modeling 

Center at National Centers for Environmental Prediction (NCEP), National Oceanic and 

Atmospheric Administration (NOAA) and became operational in March 2011.  It is a fully 

coupled model representing the interaction between the Earth's atmosphere, oceans and 

land. The variables available include precipitation and surface temperature. The forecast 

data is made available in a form of an ensemble forecast with several months lead time 

and provides ensemble input of forecasted rainfall. 

Spatial 

extent 

Global coverage (Longitude Range: 180W to 180E, and Latitude 

Range: 90S to 90N) 

Spatial and 

temporal 

resolution 

Spatial resolution: 1 degree 

Temporal resolution: daily 

Reference http://cfs.ncep.noaa.gov/  

Example of 

usage 

Ensemble members used as climate input for hydrological, water 

resource or crop models for evaluation of a future situation. 

 

Data 

requirements 

and 

calculation 

The computation consists of construction of the 20-member ensemble 

forecast. The original product is resampled from 6-hourly to daily. 

Update 

Frequency 

Daily 

Related 

indices 

SPI 1-month, SPI 3-month, etc. based on forecasted rainfall 

Data source NCEP CFS v2 

 

A corrected seasonal forecast is also available. A bias correction is applied to the 

forecast using the scale factor method. 

 

Spatial 

extent 

Global coverage (Longitude Range: 180W to 180E, and Latitude 

Range: 90S to 90N) 

http://cfs.ncep.noaa.gov/
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Spatial and 

temporal 

resolution 

Spatial resolution: 1 degree 

Temporal resolution: daily 

Reference http://cfs.ncep.noaa.gov/  

Example of 

usage 

Ensemble members used as climate input for hydrological, water 

resource or crop models for evaluation of a future situation. 

 

Data 

requirements 

and 

calculation 

The computation consists of construction of the 20-member ensemble 

forecast. The original product is resampled from 6-hourly to daily. 

CFS forecast is bias corrected based on a monthly scale factor. The 

scale factors have been derived from an analysis of the entire TRMM 

record (available from March 2000). The scale factors are estimated for 

each month of the year and for each lead-time horizon, and they 

represent the deviation of the forecast (reforecast data) with 

observation (TRMM data). 

The scale factors are then applied automatically to the forecast in order 

to take into account the deviation that observed in reforecast dataset. 

Update 

Frequency 

Daily 

Related 

indices 

SPI 1-month, SPI 3-month, etc. based on forecasted rainfall 

Data source NCEP CFS v2 

 

  

http://cfs.ncep.noaa.gov/
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3.1.3 Temperature 

The level-3 MODIS1 global Land Surface Temperature (LST) and Emissivity 8-day data 

(MOD11A2) are composed from the daily 1-kilometer LST product (MOD11A1) and 

stored on a 1-kilometer Sinusoidal grid as the average values of clear-sky LSTs during an 

8-day period.2  

LST and especially the change in temperature over time is a valuable indicator for climate 

change and drought events. 

Spatial extent Global coverage 

Spatial and 

temporal 

resolution 

Spatial resolution: 1 km but resampled to 5 km 

Temporal resolution: 8 day product from 2000 to present 

Reference https://lpdaac.usgs.gov/dataset_discovery/modis/ 

modis_products_table/mod11a2 

Example of usage Temperature in itself is NOT an index, but could be used to 

detect changes in the temperature pattern from year to year. 

 

Data requirements 

and calculation 

Download of MOD11A2 1 km 8 day product. Data resampled to 

5 km resolution using a simple mean of the grid cells. 

Update Frequency 8 day 

Data source MOD11A2 

  

                                                      

1 The Moderate Resolution Imaging Spectroradiometer 

2 https://lpdaac.usgs.gov/dataset_discovery/modis/modis_products_table/mod11a2 

https://lpdaac.usgs.gov/dataset_discovery/modis/
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Title  Temperature condition index (TCI) 

Description TCI is estimated relative to the maximum and minimum temperatures and 

modified to reflect different vegetation responses to temperature. 

 INDICATOR USAGE 

Index 

interpretation 

Used to determine stress on vegetation caused by temperatures and excessive 

wetness. 

Spatial extent Global coverage 

Spatial and 

temporal 

resolution 

Spatial resolution: 5 km 

Temporal resolution: 8 daily 

Reference Daytime land surface temperature based on the 1 km MOD11C2 product.  

https://lpdaac.usgs.gov/dataset_discovery/modis/modis_products_table/mod11c2 

Example of 

usage 

Example of the TCI coverage over Ghana: 

 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

TCI is calculated as:  

100*(Tmax - T)/(Tmax - Tmin) 

Update 

Frequency 

8 days 

Related indices - 

Data source MOD11C2 
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3.1.4 Vegetation related data 

The Normalized Difference Vegetation Index (NDVI) is used as an index of vegetation 

health and density.  

NDVI = (λNIR – λred) / (λNIR + λred)  

where: λNIR and λred are the reflectance in the NIR and red bands, respectively.  

MODIS vegetation indices are produced on 16-day intervals and at multiple spatial 

resolutions. NDVI is closely correlated to vegetation canopy greenness, a composite 

property of leaf area, chlorophyll and canopy structure, and could be used as a base data 

set for monitoring of crop and vegetation status. 

It varies between -1 and +1. Strong correlation with leaf area index and biomass 

NDVI in itself does not reflect drought or non-drought conditions, but could be used to 

detect vegetation cover. 

NDVI values Vegetation condition 

0.1 to 0.7 Vegetated land 

> 0.5 Dense vegetation 

< 0.1 Near zero vegetation such as 

barren area, rock, sand or 

snow 

NDVI in itself is NOT a drought index, but could be used to detect changes in the 

vegetation pattern from year to year. , used as source data for a number of vegetation 

indices. 

Spatial and temporal 

extent 

Global coverage 

 

Spatial and temporal 

resolution 

Spatial resolution: from 5600 m to 250 m 

Temporal resolution: Updated every 16 day based on two 

daily passes. The value is based on the maximum value 

during the 16 day period (Available from 2000 to present) 

Reference http://modis-land.gsfc.nasa.gov/vi.html and 

http://e4ftl01.cr.usgs.gov/MOLT/  

Data requirements and 

calculation 

Converted to netcdf format  

Update Frequency 16 day 

Related indices Vegetation based indices 

Data source Terra-MOD13C1 (5600 m) 

 

The following tables define the indicators we will calculate based on the NDVI dataset.  

http://modis-land.gsfc.nasa.gov/vi.html
http://e4ftl01.cr.usgs.gov/MOLT/
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Title  NDVI deviation 

Description NDVI deviation is calculated as the deviation from the long-term mean. It 

expresses the current vegetation growth compared to the long term mean 

for the same period. 

 INDICATOR USAGE 

Index interpretation NDVI deviation could be used to define a drought as it is defined as the 

difference between the NDVI for the current time step and the long term 

mean NDVI for the same month. 

DEVNDVI = NDVIi – NDVImean,m 

Where: NDVIi : NDVI for the current time step and NDVImean,m : Long term 

mean NDVI for the same month 

 When DEVNDVI is negative, it indicates the below-normal vegetation 

condition/health and, therefore, suggests a prevailing drought situation. 

 The greater the negative departure the greater the magnitude of a 

drought. 

The limitation is that the deviation from the mean does not take into account 

the variability in the vegetation within the region. Hence a negative DEVNDVI 

could be caused by a different crop type. 

DEVNDVI values Condition 

<= 0.2 Severe drought (extremely dry) 

-0.05 to -0.2 Drought (moderately dry) 

-0.05 to 0.1 Near normal 

> 0.1 Above optimal (extremely wet) 
 

Spatial extent Global coverage 

Spatial and 

temporal resolution 

Spatial resolution: 5600 m to 250 m 

Temporal resolution: 16 day 

Reference Processed based on the NDVI data 

Example of usage Location of areas with a vegetation growth below the long-term average. 
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 INDICATOR CALCULATION 

Data requirements 

and calculation 

 DEVNDVI = NDVIi – NDVImean,m 

Where: NDVIi : NDVI for the current time step and NDVImean,m : Long term 

mean NDVI for the same month 

Update Frequency 16 day 

Related indices Vegetation based indices 

Data source Based on the NDVI data 

 

 

Title  Vegetation condition index (VCI) 

Description Vegetation condition index (VCI) shows how close the NDVI of the current 

month is to the minimum NDVI calculated from the long-term record. 

 INDICATOR USAGE 

Index interpretation VCI values reflects the following: 

VCI values Condition 

50 to 100 % Optimal or above normal conditions 

35 to 50% Fair vegetation condition 

0 to 35% Severe drought (local trigger values apply) 

0% Extremely dry and equal to the long term minimum 

  

Spatial extent Global coverage 

Spatial and temporal 

resolution 

Spatial resolution: 5600 m to 250 m 

Temporal resolution: 16-day 

Reference Kogan, F. N. F. Remote sensing of weather impacts on vegetation in non-

homogeneous areas. International Journal of Remote Sensing 1990, 11, 

1405–1419. 

 INDICATOR CALCULATION 

Data requirements 

and calculation 

 VCI shows how close the NDVI of the current month is to the minimum 

NDVI calculated from the long term record. 

𝑉𝐶𝐼𝐽 =  
(𝑁𝐷𝑉𝐼𝐽 − 𝑁𝐷𝑉𝐼𝑚𝑖𝑛)

(𝑁𝐷𝑉𝐼𝑚𝑎𝑥 −  𝑁𝐷𝑉𝐼𝑚𝑖𝑛)
∗ 100 

Where: NDVImin and NDVImax are calculated for the same month from a long 
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term record.  

Update Frequency 16 day 

Related indices Vegetation based indices 

Data source Based on the NDVI data 

 

 

Title  Standardised vegetation index (SVI) 

Description SVI is NDVI normalized for each pixel on the basis of the maximum 

statistical range over the historical record. 

 INDICATOR USAGE 

Index interpretation  

SVI values Condition 

0 to 0.05 Very poor conditions 

0.05 to 0.25 Poor conditions 

0.25 to 0.75 Average conditions 

0.75 to 0.95 Good conditions 

0.95 to 1 Very good conditions 

 

Zero is the baseline condition where the NDVI is lower than all possible 

NDVI values for that period in other years. 

Spatial extent Global coverage 

Spatial and temporal 

resolution 

Spatial resolution: 5600 m to 250 m 

Temporal resolution: 16-day 

Reference Processed based on the NDVI data 

 INDICATOR CALCULATION 

Data requirements and 

calculation 

SVI is NDVI normalized for each pixel on the basis of the maximum 

statistical range over the historical record. 

Low SVI values indicate poor vegetation condition that could be the 

result of climate conditions.  

The SVI is based on a z score. The z score is a deviation from the mean 

in units of standard deviation. 

Update Frequency 16 day 

Related indices Vegetation based indices 

Data source Based on the NDVI data 
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Title  Vegetation health index (VHI) 

Description VHI is combination of vegetation condition index (VCI) and temperature 

condition index (TCI). 

 INDICATOR USAGE 

Index interpretation The following classification is used for drought related vegetation stress: 

< 10 Extreme drought 

10 to 20 Severe drought 

20 to 30 Moderate drought 

30 to 40 Mild drought 

40 to 100 No drought 

Spatial extent Global coverage 

Spatial and temporal 

resolution 

Spatial resolution: 5600 m to 250 m 

Temporal resolution: 16 day 

Reference Processed based on the NDVI data 

 INDICATOR CALCULATION 

Data requirements 

and calculation 

Calculated as: 

 VHI = 0.5 * VCI + 0.5 * TCI 

Update Frequency 16 day 

Related indices Vegetation based indices 

Data source Based on the NDVI data 
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3.1.5 Soil moisture related data 

The Soil water index (SWI) product contains daily synthesis of SWI derived from 

Advanced Scatterometer Surface Soil Moisture (ASCAT SSM) data at 25 km resolution 

(then resampled to 0.1 degree).  

The SWI algorithm, originally developed at Vienna University of Technology (TU Wien) 

and later improved by other research groups, uses an infiltration model describing the 

relation between surface soil moisture and profile soil moisture as a function of time. The 

algorithm is based on a two-layer water balance model. 

The data value used are using the largest characteristic time length giving the deepest 

penetration within the soil layers, and the values represent an average SWI across 0.5 to 

1 meter of the topsoil. 

SWI is used as an indicator for the water availability in the upper part of the root zone.  

SWI in itself is NOT a drought index, but could be used to detect changes in the soil 

moisture pattern from year to year. 

Spatial extent Global 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.1 degree Temporal 

resolution: daily 

METOP-ASCAT satellite, from 2007 – present 

Reference http://land.copernicus.vgt.vito.be/PDF/datapool/ 

and 

http://land.copernicus.eu/global/products/swi  

Update Frequency Daily 

Related indices Soil moisture based indices 

 

The following tables define indicators based on the SWI included in the web portal. 

  

http://land.copernicus.vgt.vito.be/PDF/datapool/
http://land.copernicus.eu/global/products/swi
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Title  SWI deviation 

Description SWI deviation is calculated as the deviation from the long-term mean. It 

expresses the current soil moisture compared to the long term mean for the 

same period. 

 INDICATOR USAGE 

Index interpretation SWI deviation could be used to define areas with unexpected low water 

availability in the root zone as it is defined as the difference between the 

SWI for the current time step and the long term mean SWI for the same 

period. 

DEVSWII = SWIi –SWImean,m 

Where: SWIi : SWI for the current time step and SWImean,m : Long term 

mean SWI for the same month 

When DEVSWI is negative, it indicates the below-normal water availability 

and, therefore, suggests a prevailing drought situation. The greater the 

negative departure the greater the magnitude of a potential drought. 

Spatial extent Global coverage 

Spatial and 

temporal resolution 

Spatial resolution: 0.1 degree 

Temporal resolution: Daily or 10 daily 

Reference Processed based on SWI data 

Example of usage Example of how a SWI anomaly map from the Climate Prediction Centre 

(http://www.cpc.ncep.noaa.gov)  

 

 INDICATOR CALCULATION 

Data requirements 

and calculation 

DEVSWII = SWIi –SWImean,m      where: SWIi : SWI for the current time step 

and SWImean,m : Long term mean SWI for the same month( from 2007 to 

present)   

Update Frequency Daily or 10 daily 

http://www.cpc.ncep.noaa.gov/


 

 

    

 
   

  

  

  

 74 

Data source Based on SWI data 

  



 

 

    

 
   

  

  

  

 75 

Title  SWI percentile 

Description SWI percentile expresses the percentage of soil moisture that is equal or 

below a certain amount for each year in the entire record. 

 INDICATOR USAGE 

Index interpretation A drought or water scarcity is often defined when the soil moisture percentile 

drops below 30 or 20 %. 

Spatial extent Global coverage 

Spatial and 

temporal resolution 

Spatial resolution: 0.1 degree 

Temporal resolution: daily or 10 daily 

Reference Processed based on SWI data 

Example of usage Example of SWI percentile map 

 

 INDICATOR CALCULATION 

Data requirements 

and calculation 

Calculated as the percentile value for the same period as the observed data 

(based on data from 2007 to present).  

Update Frequency Daily or 10 daily 

Data source Based on SWI data 
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Title  SWI percentile change 

Description Change in soil moisture percentile is used to evaluate the trend over a given 

period and locate areas where the soil moisture is increasing or decreasing. The 

SWI percentile is calculated for 1 week, 2 week and 1 month change. 

 INDICATOR USAGE 

Index 

interpretation 

Positive values indicate an increase in soil moisture across the period while 

negative values indicate a decrease in soil moisture across the period. 

Spatial extent Global coverage 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.1 degree 

Temporal resolution: Daily or 10 daily 

Reference Processed based on SWI data 

Example of 

usage 

Example of SWI percentile change (10 days) showing areas where the soil is 

getting wetter or dryer over the last month. 

 
 INDICATOR CALCULATION 

Data 

requirements and 

calculation 

Calculated as the change in percentile value. 

Update 

Frequency 

Daily or 10 daily 

Data source Based on SWI data 
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3.1.6 Climate change data 

Coordinated Regional Climate Downscaling Experiment (CORDEX) is a World Climate 

Research Programme (WCRP) project with the goal to produce coordinated sets of 

regional downscaled climate projections worldwide, i.e. for each continent a model 

domain was defined to run a set of Regional Climate Models (RCMs). The initiative 

responsible for the generation of RCMs for Africa is called CORDEX Africa. The RCMs 

are driven by the new generation radiative concentration pathway (RCP) scenarios at a 

horizontal resolution of 0.44 degree. 

The RCM outputs are processed into so-called delta change factors for monthly mean 

rainfall in order to indicate projected changes in monthly mean rainfall. The factors 

represent for each month the ratio between the average in the control model run (1986-

2005) and the projection model run (2081-2100). Changes are estimated for the medium 

radiation forcing scenario RCP4.5 and the extreme radiation forcing scenario RCP8.5. 

Spatial 

extent 

Global 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.44 degree  

Temporal resolution: resampled to monthly 

METOP-ASCAT satellite, from 2007 – present 

Reference  https://esg-dn1.nsc.liu.se/search/esgf-liu/ (ESGF Data Node) 

Example of 

usage 

Monthly envelope chart of precipitation delta change factors showing 

expected increase or decrease in precipitation over a certain basin. 

 

Update 

Frequency 

Static dataset 

Related 

indices 

None  

 

Based on the delta change factors we will calculate the climate change projection series 

of precipitation. These time series will be named and identified after the carbon dioxide 

emissions scenarios and the projection time period:  

http://cordex.org/
https://esg-dn1.nsc.liu.se/search/esgf-liu/
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 Precip. rcp45 2016-2035 

 Precip. rcp85 2016-2035 

 Precip. rcp45 2081-2100 

 Precip. rcp85 2081-2100 

Based on the precipitation datasets listed, we will generate an index expressing the 

number of dry days per month for each RCP scenario and projection time period. Finally, 

alongside precipitation, the datasets of temperature and potential evapotranspiration will 

also be generated and named: 

 PET rcp45 2016-2035 

 PET rcp85 2016-2035 

 PET rcp45 2081-2100 

 PET rcp85 2081-2100 

 TEMP rcp45 2016-2035 

 TEMP rcp85 2016-2035 

 TEMP rcp85 2081-2100 

 TEMP rcp45 2081-2100 

This dataset is static and will be made available through the web portal.  

3.1.7 Water body data 

The Water body data produced by the Copernicus Global Land Service (CGLS) is a 

component of the Land Monitoring Core Service (LMCS) of Copernicus, the European 

Earth Observation programme. With this dataset it is possible to detect areas covered by 

inland water along the year providing the maximum and the minimum extent of the water 

surface as well as the seasonal dynamics.  

Spatial extent Global 

Spatial and 

temporal 

resolution 

Spatial resolution: 300 m 

Temporal resolution: 10 day composite 

product. 

PROV-B sensor, from January 2014 – present 

Reference http://land.copernicus.eu/global/products/wb 

Update Frequency 10 days 

Related indices - 

 

3.1.8 Other related drought indices 

3.1.8.1 ASI 
The agricultural stress index is a combined index based VHI and crop related information. 

It is available as a seasonal index and annual one. 

 

http://land.copernicus.eu/global/products/wb
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Title  Agricultural stress index 

Description The Agricultural Stress Index (ASI) is an index based on the integration of 

the Vegetation Health Index (VHI) in two dimensions that are critical in the 

assessment of a drought event in agriculture: temporal and spatial.  

 INDICATOR USAGE 

Index interpretation ASI maps highlight anomalous vegetation growth, and potential drought, in 

crop zones during the growing season. 

Spatial extent Global coverage 

Spatial and 

temporal resolution 

Spatial resolution: resampled to the crop mask resolution 

Temporal resolution: 16-day 

Reference http://www.fao.org/giews/earthobservation/asis/index_1.jsp  

Example of usage This is an extract from the Earth observation page by FAO, where the ASI 

is also calculated in near real-time. 

 

 INDICATOR CALCULATION 

Data requirements 

and calculation 

The first step of the ASI calculation is a temporal averaging of the VHI, 

assessing the intensity and duration of dry periods occurring during the crop 

cycle at pixel level. 

The second step determines the spatial extent of drought events by 

calculating the percentage of pixels in arable areas with a VHI value below 

35 percent (this value was identified as a critical threshold in assessing the 

extent of drought in previous research by Kogan, 1995). 

Finally, each administrative area is classified according to its percentage of 

affected area to facilitate the quick interpretation of results by analysts. 

Update Frequency  Seasonal: 16-day 

 Annual: yearly 

Data source  Crop mask (raster): link to source   

 Growing season start and end (SOS/EOS) (3 seasons): link to 

source  

 VHI  

http://www.fao.org/giews/earthobservation/asis/index_1.jsp
https://lpdaac.usgs.gov/dataset_discovery/measures/measures_products_table/gfsad1kcm_v001
https://lpdaac.usgs.gov/dataset_discovery/measures/measures_products_table/vipphen_ndvi_v004
https://lpdaac.usgs.gov/dataset_discovery/measures/measures_products_table/vipphen_ndvi_v004
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 Administrative area: http://www.naturalearthdata.com/   

3.1.8.2 CDI 
The Combined Drought Indicator is a composite indicator based on SPI, SWI and NDVI 

related indices. 

Title  Combined Drought Indicator (CDI) 

Description The Combined Drought Indicator is a composite product based in these layers: 

SPI (SPI-1 and SPI-3), SWI anomaly and NDVI anomaly. 

 INDICATOR USAGE 

Index interpretation The output of this indicator is a classified layer with 5 categories named as 

Watch, Warning, Alert, Partial recovery and Recovery. 

Spatial extent Global coverage 

Spatial and 

temporal resolution 

Spatial resolution: based on the SPI resolution (from TRMM data) 

Temporal resolution: based on NDVI data (16 days) 

 

Reference http://edo.jrc.ec.europa.eu/documents/factsheets/factsheet_combinedDroughtI

ndicator.pdf  

Example of usage 

 

 INDICATOR CALCULATION 

Data requirements 

and calculation 

The calculation is based on the following logic to determine the category: 

http://www.naturalearthdata.com/
http://edo.jrc.ec.europa.eu/documents/factsheets/factsheet_combinedDroughtIndicator.pdf
http://edo.jrc.ec.europa.eu/documents/factsheets/factsheet_combinedDroughtIndicator.pdf
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 SPI-1 and SPI-3 month are the SPI indices calculated from TRMM data 

 pF: represents the Soil moisture based on SWI anomalies 

 fAPAR: is replaced by the vegetation index based on NDVI anomalies 

 

Update Frequency 16-day 

Data source  SPI computed from TRMM data 

 SWI  

 NDVI 

 

3.2 Functionality 

This section contains a brief description of the functionalities currently available from the 

Data and Information application.  

3.2.1 Info menu 

The information menu allows the user to access the User guide, About description, the 

Data status for the basin and Download all GIS layers associated to this basin. 

 

Figure C-11 Information menu 



 

 

    

 
   

  

  

  

 82 

3.2.1.1 User guide 
Opens a pdf version of the user guide. 

3.2.1.2 Knowledge portal 
Opens and login to the knowledge portal, which is a discussion forum for all users of the 

portal. 

 

Figure C-12 Knowledge portal landing page 

3.2.1.3 About 
Opens a short description of the system and contact information to the administrator. 

3.2.2 Data menu 

3.2.2.1 Select menu 
The Select menu is used to select the favourite data or the data available for viewing and 

analysis. The user selection is stored and will be used the next time the user logs in.  
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Figure C-13 To open the Select menu 

The Select favourite data dialog contains the following information: 

 Overview of all available data in the Data and Information application (for the 

particular focus area) 

 When clicking on a data type a brief description is displayed. 

 When selecting one or several data types and pressing “Update” the selected 

data will be available for viewing and analysis. 

 

 

Figure C-14 Select menu 
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Figure C-15 Available data in the Data tab is updated based on the selection in the Select menu. 

3.2.2.2 Layer visibility 
The Data menu is used for viewing the data types selected in the Select dialog. The 

following functionality and information is available: 

 List of available data types (based on the selection in the Select dialog) 

o Select or unselect a data type from the list 

o When selecting a data type it appears on the map view showing the most 

recent time stamp 

 Legend for the selected data type could be toggled on and off through the 

“Legend” option 

 Timeline for the selected data type is shown at the bottom of the screen. Gaps in 

the time line denotes periods with missing data 

o Click within the time line to view the data at the specific time step 

 Current time step is shown at the lower right part of the screen 

o Use the step forward or backwards buttons to change the time step 
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Figure C-16 Overview of functionality in the Data menu 

3.2.2.3 Tool functionality 
The Tools menu opens below the data type selection allowing the user to download data 

and perform a simple processing such as area-weighted time series. 
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Figure C-17 Available tools 

When opening the Tools menu a dialog with options for a) tool selection and b) tool 

configuration.  

The available tools depends on the selected data layer.  

 

Figure C-18 Available tools will be displayed depending on the selected data layer 

Tool raster file (download netcdf file) 
The “Raster file” tool is used to download the selected data type as a netcdf file. To 

download the data file: 

 Select the data type and select the “Raster file” tool 

 Specify the time period to download data for 

 Press the “Extract” button which will calculate the estimate file size and display 

this in a dialog 

 Press “Download” to download the file as a netcdf file  
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Figure C-19 Specify the time period to download data for, click on Download and then a dialog with 

the estimated file size will appear. 

Note: the zip file contains the raster as .nc file, which can be open in most GIS tools. In 

addition, a legend file as .qml are associated to the .nc file. This legend file can be used 

in QGIS to load the default symbology. 

Tool area (time series and plotting tools) 
The tools operate on different spatial resolutions – available options depend on the 

selected tools. The options are: 

 All focus area. The tools produces an area weighted time series for the entire 

focus area. 

 User location. Time series extracted at user specified locations (see following 

section for more details). 

 Subarea layer. Time series processed as area weighted time series for a user 

specified subarea. 

 Point layer. Time series processed as area weighted time series for a user 

specified point location. 

Pressing the “Download” button downloads the data as a csv file. Pressing the “Chart” 

button displays a plot with the tool result. 

 

Figure C-20 Tools are available at different spatial resolutions (options depend on the selected tool) 
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All focus area 

Selecting the “All focus area” produces an area-weighted result of the data type for the 

entire focus area, see Figure C-21 for an example with a time series tool. The time series 

plot is shown with area weighted data and long term average data. 

 

Figure C-21 Area weighted plot for the entire focus area 

Subarea layer 

When selecting the “Subarea layer” a selection of the available subareas appears. 

Selecting a subarea will highlight the area on the map. Pressing “Chart” will produce a 

plot with the area weighted results, pressing “Download” will download the data.  

 

Figure C-22 Subarea selection 
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Point layer 

When selecting the “Point layer” a selection of the available locations appears. Selecting 

a point will highlight the location on the map. Pressing “Chart” will produce a plot with the 

area-weighted results, pressing “Download” will download the data.  

 

Figure C-23 Point layer selection 

User location 

The “User location” allows the user to extract data from the data layer at user specified 

locations. The procedure are: 

 Click on the map to define the location. 

 The system will retrieve the data at the location. 

 Several locations can be retrieved. 

 Press the “Download” button to get the data 
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Figure C-24 User location selection 

Time series Tool 
The time series tool produces an area weighted time series for the selected area. The 

time series uses the same temporal resolution as in the data file. 

 

Figure C-25 Output from Time series tool 
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Time series (monthly) Tool 
The time series tool produces an area weighted time series for the selected area. The 

time series contains monthly accumulated values, and contains an item with the actual 

data (black) and an item with the long-term mean of each of the monthly time steps (red). 

 

Figure C-26 Output from Time series (Monthly) tool 

Envelope plot Tool 
This tool is only available for ensemble based data types, and produces a plot showing 

the median, 25 percentile and 75 percentile of the ensemble values. 

 

Figure C-27 Output from Envelope tool 

Column chart Tool 
The column chart tool is only available for selected indices, and produces a plot showing 

the coverage, in percentage, of different drought or flood categories.  
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Figure C-28 Output from "Column chart" tool 

3.2.2.4 Tool tips 
Tips are available for all layers and tools by clicking on the layer name or tool name. 

 

Figure C-29 Tips displayed for a selected layer. 

3.2.3 Document menu 

The document menu opens a dialog listing the available documents associated with the 

particular focus area. The documents could be fact sheets with more information on 

specific data types, video showing the temporal and spatial change of a data type, 

custom made drought reports or other documents associated with the specific focus area. 
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Figure C-30 Document menu showing a list of available documents  

3.2.4 Map menu 

The map menu allows the user to select between different background maps. 

 

Figure C-31 Base map menu to select background map 
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4 Annex D: Drought Assessment 

This section contains a description of the functionalities in the Drought Assessment 

application. 

4.1 Drought Warning  

The Drought Warning page allows the user to select a specific layer and apply a 

threshold value to highlight the areas that are affected by a specific hazard. 

 

Figure D-32 Drought Warning tab in Drought Assessment app 

 

4.1.1 Warning threshold and comparison 

The warning functionality allows the user to filter out the area of the basin that are under 

a given hazard. 
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 Threshold: this is a user-defined value. The unit changes for each layer. 

 Comparison: The choice is either larger or lower. 

 View original: this option displays the original layer without any threshold 

applied. 

The example below illustrates how the warning threshold functionality can be used to 

highlight the area under meteorological drought based on the EDI value. The number of 

consecutive days with EDI value below the critical value is computed for the entire basin 

(left picture). Then a first threshold of 5 days is applied (middle picture). The user is also 

able to modify the threshold value to update the map (right picture). 

 

 

  

Orginal layer 

Consecutive days with EDI 

value less -1 

 Warning layer 1 

Area where number of 

consecutive days with EDI 

value less -1 is more than 5 

days 

Warning layer 2 

Area where number of 

consecutive days with EDI 

value less -1 is more than 20 

days 

4.1.2 Warning descriptions 

The layers used for warning are computed automatically with the latest available 

information. The layer is always made of one time step (the latest available in the related 

dataset). 

The layers are grouped based on the dataset there calculated from. Below is a 

description all the layers currently available with a short description. 

Drought: based on the various drought indices 

 ASI latest value: Latest value of the ASI for Season 1 

 Number days with EDI value less than -1 (30d): Number of days with EDI 

value less than -1 during the last 30 days 

 Consecutive days with EDI value less -1: Maximum number of consecutive 

days with EDI value less than -1 during the last 30 days 
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 Days with VCI less than 20 (30d): Number of days with VCI value less than 20 

during the last 30 days 

 Days with VHI less than 30 (30d): Number of days with VCI value less than 30 

during the last 30 days 

Rainfall forecast: Based on the latest medium range forecast 

 Acc. rainfall next 10 days: Accumulated rainfall for the coming 10 days (date is 

the last day in the accumulation) 

Rainfall (GPM): Based on the latest GPM data 

 Number of consecutive dry days (30d): Number of consecutive dry days (< 2 

mm/day) during the last 30 days 

 Days since rain: Number of days since last rainfall event (> 2 mm/day) 

 Number of dry days (30d): Number of dry days (< 2 mm/day) during the last 30 

days 

 Accumulated rainfall (14d): Accumulated rainfall during the last 14 days 

 Accumulated rainfall (1d) : Accumulated rainfall during the last 1 day 

 Accumulated rainfall (30d) : Accumulated rainfall during the last 30 days 

 Accumulated rainfall (7d): : Accumulated rainfall during the last 7 days 

 Number of wet days (30d): Number of wet days (> 2 mm/day) during the last 30 

days 

Rainfall (TRMM): Based on the latest TRMM data 

 Number of consecutive dry days (30d): Number of consecutive dry days (< 2 

mm/day) during the last 30 days 

 Days since rain: Number of days since last rainfall event (> 2 mm/day) 

 Number of dry days (30d): Number of dry days (< 2 mm/day) during the last 30 

days 

 Accumulated rainfall (14d): Accumulated rainfall during the last 14 days 

 Accumulated rainfall (1d) : Accumulated rainfall during the last 1 day 

 Accumulated rainfall (30d) : Accumulated rainfall during the last 30 days 

 Accumulated rainfall (7d): : Accumulated rainfall during the last 7 days 

 Number of wet days (30d): Number of wet days (> 2 mm/day) during the last 30 

days 

4.2 Drought Risk 

The Drought Risk page provides an interface to assess risk based on hazards and 

vulnerability. The main output of this page is a map with overlaid hazard and vulnerability. 
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Figure D-33 Drought Risk tab in Drought Assessment app 

4.2.1 Edit the legend 

The legend of each layer can be edited as shown in Figure D-34. For each category it is 

mandatory to specify: 

 Min value: this value should match the previous Max value (if any) 

 Max value: this value should match the next Min value (if any) 

 Colour: this is a hexadecimal colour code3 

                                                      

3 Web site such as http://colorbrewer2.org can be used to get hexadecimal color codes. 

http://colorbrewer2.org/
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Figure D-34 Edit the legend of the risk layers 

4.2.2 Edit the transparency 

 

  

Default transparency settings Updated transparency setting to highlight 

vulnerable areas 

Figure D-35 Risk layers opacity/transparency settings 
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4.2.3 Hazard description 

The hazards layers are similar to the layer found in the Drought Warning tab, without the 

threshold applied. 

The layers are grouped based on the dataset there calculated from. Below is a 

description all the layers currently available with a short description. 

Drought: based on the various drought indices 

 ASI latest value: Latest value of the ASI for Season 1 

 Number days with EDI value less than -1 (30d): Number of days with EDI 

value less than -1 during the last 30 days 

 Consecutive days with EDI value less -1: Maximum number of consecutive 

days with EDI value less than -1 during the last 30 days 

 Days with VCI less than 20 (30d): Number of days with VCI value less than 20 

during the last 30 days 

 Days with VHI less than 30 (30d): Number of days with VCI value less than 30 

during the last 30 days 

Rainfall forecast: Based on the latest medium range forecast 

 Acc. rainfall next 10 days: Accumulated rainfall for the coming 10 days (date is 

the last day in the accumulation) 

Rainfall (GPM): Based on the latest GPM data 

 Number of consecutive dry days (30d): Number of consecutive dry days (< 2 

mm/day) during the last 30 days 

 Days since rain: Number of days since last rainfall event (> 2 mm/day) 

 Number of dry days (30d): Number of dry days (< 2 mm/day) during the last 30 

days 

 Accumulated rainfall (14d): Accumulated rainfall during the last 14 days 

 Accumulated rainfall (1d) : Accumulated rainfall during the last 1 day 

 Accumulated rainfall (30d) : Accumulated rainfall during the last 30 days 

 Accumulated rainfall (7d): : Accumulated rainfall during the last 7 days 

 Number of wet days (30d): Number of wet days (> 2 mm/day) during the last 30 

days 

Rainfall (TRMM): Based on the latest TRMM data 

 Number of consecutive dry days (30d): Number of consecutive dry days (< 2 

mm/day) during the last 30 days 

 Days since rain: Number of days since last rainfall event (> 2 mm/day) 

 Number of dry days (30d): Number of dry days (< 2 mm/day) during the last 30 

days 
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 Accumulated rainfall (14d): Accumulated rainfall during the last 14 days 

 Accumulated rainfall (1d) : Accumulated rainfall during the last 1 day 

 Accumulated rainfall (30d) : Accumulated rainfall during the last 30 days 

 Accumulated rainfall (7d): : Accumulated rainfall during the last 7 days 

 Number of wet days (30d): Number of wet days (> 2 mm/day) during the last 30 

days 

4.2.4 Vulnerability description 

Socio-economic 

 Child under weight (percentage): Percentage of children, under the age of 5, 

who are underweight (year period: 1990-2002) 

 Drought Mortality Risk: Global Drought Mortality Risks and Distribution is a 2.5 

minute grid of global drought mortality risks. Gridded Population of the World, 

Version 3 (GPWv3) data provide a baseline estimation of population per grid cell 

from which to estimate potential mortality risks due to drought hazard. Mortality 

loss estimates per hazard event are calculated using regional, hazard-specific 

mortality records of the Emergency Events Database (EM-DAT) that span the 20 

years between 1981 and 2000. 

 Flood Mortality Risk: Global Flood Mortality Risks and Distribution is a 2.5 

minute grid of global flood mortality risks. Gridded Population of the World, 

Version 3 (GPWv3) data provided a baseline population per grid cell from which 

to estimate potential mortality risks due to flood hazard. Mortality loss estimates 

per flood event are calculated using regional, hazard-specific mortality records of 

the Emergency Events Database (EM-DAT) that span the 20 years between 

1981 and 2000. 

 Gross Domestic Product: In the distributed global GDP dataset sub-national 

GRP and national GDP data are allocated to approximately 1km grid cells in 

proportion to the population residing in that cell. The method also distinguishes 

between rural and urban population, assuming the latter to have a higher GDP 

per capita. 

 Infant Mortality Rate (2000): Infant mortality rate, adjusted to the year 2000, in 

deaths per 10,000 live births. 

 Population density (2010): estimate of population density for the years 2010 

based on counts consistent with national censuses and population registers, as 

raster data to facilitate data integration. 

 Population density (2015) estimate of population density for the years 2015 

based on counts consistent with national censuses and population registers, as 

raster data to facilitate data integration. 

 Population density (2020) estimate of population density for the years 2020 

based on counts consistent with national censuses and population registers, as 

raster data to facilitate data integration. 
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 Urban expansion (2030) estimate of population density for the years 2030 

based on counts consistent with national censuses and population registers, as 

raster data to facilitate data integration. 

Agriculture 

 Crop Mask: provides an estimate of the rainfed croplands areas 

 Irrigated Area: The map shows the amount of area equipped for irrigation 

around the year 2005 in percentage of the total area on a raster with a resolution 

of 5 minutes. 

 Pasture (2000): Global Agricultural Lands in 2000 represent the proportion of 

pixel that is either under cropland or pasture. 
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5 Annex E: Reporting 

This section contains a description of the functionalities in the Reporting application. 

5.1 Open report 

The “Open” menu enables an overview of all accessible reports, based on the workgroup 

concept.  

5.2 New report 

The “New” menu enables the user to generate a new report. The following input are 

required: 

 Report title: Report title as it will appear in the system 

 Description: Short description of the report. 

 Template: Report template in Word format (docx format). The reporting template 

should contain tags in the form of brackets with a text (e.g. ” {this is a reporting 

tag}”) 

 Update frequency (optional): The frequency for automated update of the 

reports in weeks. The minimum time between two reports will be one day. No 

report will be generated automatically if left blank. 

 Alert email (optional): Email addresses to be notified when updated report has 

been generated based on the frequency. Several email addresses can be 

specified. No report will be generated automatically if left blank. 

 

Figure E-1 New report 
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When pressing the “Add” button a new reporting template will be generated and the list of 

the tags in the report template will be listed. The user should then specify the content of 

each of the tags before generating the report. 

5.2.1 Default report templates 

All reports marked with a “*” in front of the name are default report templates. The 

Reporting application contains a number of built in default reporting templates enabling 

the user to generate reports with a default content without having to develop their own 

Word based template. The default templates could also be used as a starting point for a 

user defined report.  

The default reporting templates are accessed through the “Open” menu, where the all the 

default templates are marked with a “*” in from of the name, see Figure 39. Please note 

the following: 

 Default reporting templates are all developed by the system and are available as 

read only templates (user needs to clone the template to use them). 

 ”Generate” is disables 

In order to use a default reporting template within a specific basin please follow the 

following procedure: 

 Select a default reporting template (through the “Open” menu”) 

 Clone the reporting template 

o Specify a name for the cloned version 

o Specify the workgroup for the cloned version of the report 

o Update the description if needed 

 Press “Clone” to copy the default reporting template. 

After the reporting template is cloned the “Generate” option will be enables and the user 

can now generate the report for this specific basin. The report will be populated with 

updated content and can be viewed after the “Generate” option is executed. 

5.2.2 New report template 

It is possible to create a new template as a Report template in Word format (docx format). 

The reporting template should contain tags in the form of brackets with a text (e.g. ”{this 

is a reporting tag}”) 

For maps, it is recommended to add a frame around the text, this frame will then be 

adjusted around the map added as picture to the Word document. The best way is 

actually to create a one cell table, inside which the picture will be added, see below an 

example. Please note that a negative left indent will be give better result. 
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Figure E-2 Tags to be used as a map placeholder 

 

 

Figure E-3 Properties of the table 

5.3 Clone report 

The “Clone” menu creates a copy of a report and saves it in a new user specified name. 

Note that the user has the option of selecting the workgroup for the cloned report. 

5.4 Edit report 

The “Edit” menu enables the user to change or edit the report title, the description, 

change the reporting. 
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Figure E-4 Edit dialog 

5.5 Delete report 

The “Delete” menu deletes the current report. Please note that the template and all the 

settings will be deleted from the system. The “Delete” menu is only enabled if the user is 

the author of the current report.  

5.6 Edit or preview reporting tags 

When opening a report with editing rights, refer to user workgroup, all the content of the 

reporting template will be editable. When pressing the edit button ( ) an Edit dialog is 

opened and the user is able to specify the content for the specific tag. Pressing the 

preview button ( ) enables the user to pre-view the content of the specific tag. 
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Figure E-5 Edit reporting content 

5.7 Generate report 

The “Generate” menu creates the report based on template file and the user input for 

each of the reporting tags. The final report is converted to pdf format and will be available 

for download or through a link. The “Generate” option is used when a user needs to 

update the content of the report.  

5.8 Download report 

The “Download” menu enables the user to download already generated reports. Please 

note that this menu only downloads the existing report with the current content, the 

content of the report is not updated.   

5.9 Copy link 

The “Copy link” function copies a url or link to the latest generated report. The link could 

be used when submitting an email providing a link to the latest generated report. Pasting 

the link into any internet explorer would provide access to the report.  

5.10 Upload reporting content 

The user is able to upload content into the system, which could be a specific logo or a 

description within a txt file. The upload function is enables by selecting “Upload” tab. 

 

 

Figure E-6 Upload tab 
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User uploaded items could be in the form of images (*.png files), chart (*.csv file), tables 

(*.csv files) or text (*.txt files). The procedure for uploading an item and making it 

available for a reporting tag is explained below, see also Figure E-7. 

Procedure for uploading an item and making it available for a reporting tag: 

 Select the “Upload” tab 

 Press “New” and specify the information for the item to upload 

o Item: Name for the item as it will appear for the user 

o Description: Description as it will appear for the user 

o Type: Select the type of item to upload. Please note that the system will 

NOT validate the uploaded images or csv files and errors might occur if a 

file type is specified with a wrong extension type.  

o File: Browse and select the file to upload 

 The uploaded item will now appear in the list of uploaded items 

o Note that an uploaded item can be deleted, edited or cloned by the user 

 When editing a tag in a reporting template all user uploaded items are available 

by selecting the source type “Upload”.  

 Selecting an item within the source type “Upload” adds the uploaded item to the 

specific reporting tag. 

 

Figure E-7 Process for uploading an item and making it available for a reporting tag 
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5.11 Automated reporting 

Based on the frequency, the update of reports can be automated. The Reporting 

application will automatically generate a new report, when the last generated report is 

older than the user-defined frequency. Several email recipients can be specified in the 

Alert email field to be informed when a new report has been produced. 

 

Figure E-8 Edit dialog of the report where frequency and email can to be specified. 

A notification is sent by email when a new report has been generated. The email contains 

a link to download the report as PDF without having to login to the Flood and Drought 

portal. Indication about the next report is also added to the email to the recipients have an 

idea when will the next update.  

 

Figure E-9 Example of email notification sent when a new report has been generated 

 


